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Introduction

The following topics are covered in this chapter:

O Overview
O System Requirements

O Specifications



MX-AOPC UA Logger Introduction

Overview

With most remote data acquisition systems, during daily operations additional human resources are needed to
collect data manually from remote storage devices for loading into a database. Even with RTUs remotely
collecting data over a network, software must be developed to handle the task of converting and uploading
data logs. Moxa’s MX-AOPC UA Logger not only makes real-time data collection much easier, it also simplifies
the conversion of historical data into database-ready formats. Moxa’s MX-AOPC UA Logger interacts directly
with our MX-AOPC UA Server, working as a bridge between field data and stored databases or spreadsheets.
Furthermore, the MX-AOPC UA Logger converts and uploads data logs to the central database. The MX-AOPC
UA Logger can collate tags from individual Moxa RTU or remote 1/0 devices into the same database or
spreadsheet, freeing users from the need to manipulate data after processing.

One of the benefits of using RTUs is that data can be collected over a network from a central site. In an ideal
operation, following a network failure RTUs should be able to transmit data logs that were collected while the
network was offline. Moxa’s MX-AOPC UA Logger makes this not only possible, but easy. MX-AOPC UA Loggers
provide a standard OPC interface that interacts with MX-AOPC UA Servers for real-time data collection. After
each network connection, an MX-AOPC UA Logger will compare historical data stored on the microSD cards
located in individual devices with the real time data it has already stored locally, and then supplement any
missing data by requesting that the RTU retransmit the lost data.

The MX-AOPC UA Logger includes:

= Logger Runtime Service: Starts as a service by default after installation.

= Configuration Console: An offline configuration tool for configuring settings.

System Requirements

Hardware Requirements

CPU: Intel Pentium 4 or above

RAM: 512 MB (1024 MB recommended)
Communication Interface: Ethernet or serial

Software Requirements

Operating System: Microsoft Windows 7/8/10, Microsoft Windows Server 2003/2008/2012
Editor (optional): Microsoft Office 2003 (Access or Excel) or later

Database (optional): Oracle database, Microsoft SQL Server

Specifications

OPC Specifications
OPC Unified Architecture: 1.02

Products that Support Data Supplement
Model Names: ioLogik 2500 series
Note: Please check Moxa’s website for the most up-to-date list of supported products.

Fully Supported OPC UA Client Profiles

. Core Client Facet

. User Token: User Name Password Client Facet
. User Token: X509 Certificate Client Facet

. Security Policy: Basic128Rsal5

. Security Policy: None

. Data Access Client Facet

. UA-TCP UA-SC UA Binary

o Attribute Write Client Facet

. Data Change Subscriber Client Facet
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Getting Started

The following topics are covered in this chapter:

a

a
a
o
a

QQaaa

Designing the System Architecture

Installing the MX-AOPC UA Logger

Opening the Configuration Console

Configuring the MX-AOPC UA Logger Settings
Connecting to the MX-AOPC UA Server

» Getting the Server Endpoint from the MX-AOPC UA Server
» Connecting to MX-AOPC UA Servers

Creating Loggers

Starting Runtime Service

Starting Recording

Testing the Data Supplement Function



MX-AOPC UA Logger Getting Started

Designing the System Architecture

The MX-AOPC UA Logger provides two main functions.

= Storing real-time data collected through an MX-AOPC UA Server from individual 1/0 devices to a database
or spreadsheet.

= Retrieving buffered data stored on a microSD card located in a Moxa device that supports data buffering,
such as the Moxa ioLogik 2500 series, and then supplementing the database or spreadsheet with missing
data.

We recommend using one of the following two scenarios when designing the system architecture:

Scenario 1: Write real-time data to a database or spreadsheet

= MX-AOPC UA Logger saves data from selected OPC tags to a database or spreadsheet. The data comes from
MX-AOPC UA Server only, which collects data from field devices.

= MX-AOPC UA Server, MX-AOPC UA Logger, and Database can be installed either on the same computer or
on different computers. We strongly recommend installing MX-AOPC UA Logger and Database on the same
computer.

OPC UA
OPC DA
MX-AOPC UA Server MX-AOPC UA Logger Database
B = > H e »
Static IP oL HENs |
W 4
| ‘&-_-1
Mg aur ORACLE
Modbus
DATABASE
Static IP & SQLServer
T ::.-\I
S
! -
Remote I/0

Scenario 2: Collect real-time data while the network is up and running, and

retrieve buffered data stored in Moxa devices when the network is

disconnected

= When network communication is reestablished, the MX-AOPC UA Logger automatically retrieves buffered
data saved on microSD cards installed in Moxa’s devices when the network was disconnected.

= After retrieving data from the data logs, the MX-AOPC UA Logger automatically saves the data to the
database or spreadsheet.

= The MX-AOPC UA Logger supplements data only for OPC tags, which are selected both in the AOPC function
of the Moxa device with the 10xpress utility (AOPC > Tag Selection), and in the Logger settings of the
MX-AOPC UA Logger with its configuration console.

= For this scenario, microSD cards must be installed in your Moxa devices.

2-2



MX-AOPC UA Logger Getting Started

= The MX-AOPC UA Logger’s data supplement function must be enabled (the default), which can be done with
the configuration console under Tools - Data Supplement Settings.

= If the IP address of the Moxa cellular device is private or dynamic, Cellular Data Access software must be
used to enable the MX-AOPC UA Logger to access Moxa cellular devices. We recommend installing the
Cellular Data Access software and MX-AOPC UA Server on the same computer. Use Moxa’s 10xpress utility
to enable the Cellular Data Access function on the Moxa cellular device at Network - Cellular - Cellular
Data Access. Use the MX-AOPC UA Logger’s configuration console at Tools - Data Supplement
Settings.

When the Moxa cellular device uses a static IP

OPC UA
OPC DA
MX-AOPC UA Server MX-AOPC UA Logger Database
.; OPC UA g:! ODBC g
Static IP ) .
- 2
X (&
Moxa AOPC oRACLE
DATABASE
Static IP . SQLServer
Remote I/0

When the Moxa cellular device uses a private or dynamic IP

SCADA
Ll
RNy
e
OPC UA
OPC DA
MX-AOPC UA Server MX-AOPC UA Logger Database
W «— H «— 8§
Static Ip b / ODBC o
X (A
g
Moxa AQPC o T ORACLE’
/ Cellular Data Access DATABASE
. . }9
Private or Dynamic IP < SQLserver
i -
-
Remote I/0
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The following software can be downloaded from Moxa’s website at www.moxa.com:

= MX-AOPC UA Logger v1.0 or later
= MX-AOPC UA Server v1.4 or later

e Cellular Data Access v1.2 or later

= |Oxpress utility v2.0 or later

= Moxa device firmware that supports the data supplement function:

» ioLogik 2500 series

ioLogik 2500-Ethernet V2.0 or later
ioLogik 2500-HSPA V2.0 or later
ioLogik 2500-GPRS V2.0 or later
ioLogik 2500-WL1 V2.0 or later

Refer to the MX-AOPC UA Server User’s Manual for instructions on how to install and configure Moxa’s MX-AOPC

UA Server software.

Refer to your Moxa device’s user’s manual for instructions on installing 10xpress and Cellular Data Access on a

computer, and for updating your Moxa device’s firmware.

Installing the MX-AOPC UA Logger

The MX-AOPC UA Logger can be downloaded from Moxa’s website at www.moxa.com.

After downloading the file, unzip it and run setup.exe. The installation program will guide you through the

MX-AOPC UA Logger installation process.

Opening the Configuration Console

Open the MX-AOPC UA Logger’s configuration console from the Windows Start menu: Start > All Programs
2> MOXA - 10 Server > MX-AOPC UA Suite > MX-AOPC UA Logger.

Select the appropriate main network adapter the first time you open the configuration console.

Select Main Network Adapter L&]

Main Metwork Adapter: | Intel(R) Ethernet Connection (3) 1218-41M 'I

Mote: The main network adapter needs to be enabled for starting runtime service.
This setting cannot be modified after this configuration.

K ] l Cancel
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MX-AOPC UA Logger Getting Started

The configuration console is an offline configuration tool for configuring Logger Runtime settings. When the
configuration console is launched, it will automatically get the latest configurations from the Logger Runtime.

ra ] ™
Fi

le Server Logger Tools Runtime Help

TEEPERTEHRGO008HE

------- ﬁ Server Group

...... E4 Logger Group List

Date Time Event

4 m b

Service Status : Stopped Time: 11:27:36

Configuring the MX-AOPC UA Logger Settings

The MX-AOPC UA Logger settings described below can be configured under the Tools menu.

i MXAOPC UA Logger

File Server Logger ITm:rls| Runtime Help

-— mmm e Data Supplement Settings b ﬁ
Loy B -

Certificate Management

------- ﬁ Server Group
System Log <

Change Password

Opticns

| - E Logger Group List

= Change Password

We strongly recommend changing the password the first time you use the Configuration Console. The
default password is moxa, which is needed for verification when exporting the system log to a text file.
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< Data Supplement Settings
Select the Data supplement after network reconnection checkbox if the Moxa product supporting the
data supplement function is connected to an MX-AOPC UA Server.

Select the Data Supplement through Cellular Data Access checkbox if the IP address of the Moxa

cellular device is private or dynamic.

Data supplement after network reconnection

Retry Timeout 30 sec(s) (5 to 600, default: 30)
Retries 3 {0 to 10, default: 3)
[ Data supplement through Cellular Data Access

IP Address a . 0 . o ., 0

Port |9400 {0 to 65535, default: 3400)

Folder for supplementary data

Path C:-‘i.l_Jseré\Fu.bii;:‘lbumments.‘l.i'ﬂuxawanPCL; E]

| ok || cancel |
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* Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsal5: Sign, Basic1l28Rsal5: Sign
and Encrypt, or both, importing an OPC UA client’s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC UA
Logger.

Trust Servers | Instance Cerﬁﬁmtes|
Server Mame URI
i MX-AQPC LA Server urn:CHARLESCHEM-ME:MX-AQPC UA Server
4 | 1l | b
[ Import... ] i Export... i |  Remove i i Trust i i View Certificate... |

Close




MX-AOPC UA Logger Getting Started

Select the Instance Certificates tab and click on Export Logger Certificate to export the MX-AOPC UA
Logger’s CA file to the OPC UA Server.

cenifcates Managemer )
Trust Servers | Instance Certificates |

[ View Logger Certificate. .. ] Certificate MX-AOPC UA Logger is from
2016/4/14 9 05:38:38 to 2021/3/19
] L+ 06:38:38

[ Export Logger Certificate. ..

[ Reissue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.
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Connecting to the MX-AOPC UA Server

Getting the Server Endpoint from the MX-AOPC UA Server

Select Tools > OPC UA Settings - Server Endpoint Settings to go to the MX-AOPC UA Server
configuration console to copy the MX-AOPC UA Server’s Server Endpoint.

Ensure that the status of the Server Endpoint is Valid.

Server Endpoints SEI'_ (X

URL Status
opc. top:ff192, 168, 34, 10: 5319 2/MXACPC UAServer Valid
Metwork Interface: |Intel(R) Ethernet Connection (3) 12184M -

Port Mumber: 53192

opc. top:ff192, 168, 34, 10: 53192/ MXACPC JUAServer

(aea ) (osee ) [ ] (oo ]

Connecting to MX-AOPC UA Servers

1. Click the Server Group and then click the Discovery icon to start discovering MX-AOPC UA Servers.

£ MicAOPC UA Logoer

Eile 5Server Logger JTools Runtime Help

N altERSER G008

----- ﬁ Server Group

------ & Logoer Group List
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2. Select the Local Server option if MX-AOPC UA Server and MX-AOPC UA Logger are installed on the same
computer. Otherwise, select the Remote Server Endpoint option and paste in the Server Endpoint from the
previous step. Type in the MX-AOPC UA Server’s password and then click Next.

scovery server &

@ Local Server

| opc. tcp://192. 168. 34. 10:53192/MXACPC/UAServer -

") Remaote Server Endpoint

Password L Ll

| <Back || Next> | | cancel
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3. Modify Server Name, and configure Security Policy and Security Mode, which should be the same as the
MX-AOPC UA Server’s UA Settings. If necessary, change the Publish Interval, Sampling Interval, Queue
Size settings, and select or deselect the Discard Oldest settings checkbox, and then click Finish.

orcoryserer R, ==

Server Mame  Serverl {max. length = 30; ™. is not allowed)

Server Endpoint:  opc.top: /192, 168. 34, 10: 53192 MXACQPC UAServer

Security Policy [None - ]

Security Mode [None o ]

Subscription Settings

Publish Interval 1000 ) EJ. ms (0 to 36400000, default: 1000)

Keep Alive Count i 10 i

Lifetime Count i 1000 i

Maonitored Item Settings
Sampling Interval 500 gll me (-1 to 86400000, default: 500)
=t
QueueSize 10 ] (0to 10000, default: 10)
=]

Discard Oldest

| <Back || Fmsh || cancel |

4. Select the server and click the Connect icon to connect to the MX-AOPC UA Server.

00 U ogger T R

File Server Logger Tools Runtime Help

A — = > =, F
TEEBERSESRG0088
= ﬁ Server Group

‘ Server1(192. 168,34, 10:53192)

—

Server Endpoint: opc. tep: /192, 168,34, 10: 53192/MXAOPC JUAServer

Security Policy: None

Security Mode: None

-4 Logger Group List

Subscription Settings Manitored Item Settings
Publish Interval: 1000 Sampling Interval: 500

Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
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5. Once the server is connected, you will not be allowed to change the server connection settings. To change the
server connection settings, click the Disconnect icon to disconnect the MX-AOPC UA Server, and then click
the Properties icon to change the server connection settings.

1 MX-AOPCUALogger e YT 7T
File Server Logger Tools Runtime Hglp

— T, —— —
TE AR BRE
=k ﬁ Server Group
E Server1{192.168.34.10:53192) Server Endpoint:  opc.tep://192. 168. 34. 10:53192/MXACPC UAServer
Security Policy: MNone

Security Mode: None

- B4 Logger Group List

Subscription Settings Maonitored Item Settings
Publish Interval: 1000 Sampling Interval: 500
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest: Yes

,E.j MX-AOPC UA Logg
Eile Server Logger Tools Runtime Help

rEmsBeERSgRlGo0ss

= ﬁ Server Group

ﬂ Server1(192.168.34.10:53192) Server Endpoint:  ope. tep /192, 168, 34, 10:53192/MXAOPC UAServer

Security Policy: Maone

Security Mode: Maone

-4 Logger Group List

Subscription Settings Monitored Item Settings
Publish Interval: 1000 Sampling Interval: 500
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes

NOTE Ensure that the server connection is in connecting status before starting to record data to a database or
spreadsheet.
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Creating Loggers

1. To create a data Logger, click Logger Group List, click the New Logger Group icon, and then type in the
name of the logger group.

E MCAOPCUALogger T —

___Eile Server I:ﬂgger__ Tools Runtime Help

=0 B = G
TEEBE

B-- ' Server Group

....... 5 Server1(192.168.34.10:5

5 oo Gop et
Loggercroup Propery S

Logger Group Mame LoggerGroupl

(max. length = 30; "."is not allowed)

2. Click the logger group, and then click the New Logger icon to create a logger.

2-13
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3. Type in the name of the logger, select Excel File, Access File, or Database, and then modify the root path,
or set the source name of the database. Click Next to continue.

&1 MX-AOPC UA @—‘—'—-—_

File Server Logger Tools Runtime Help

—
|
e, S

(=0 ' Server Group
- [ Server1(192.168.34,10:53192) il

Output

Logger Name

(max. length = 30)

- LoggerGroupl

@) Excel File
Root Path: C:\sers\Public\DocumentsMoxa\MXACPCLogger \Logger [I]

() Access File:
Root Path: C:\Wsers\Public\Documents \Moxa \MXAOPCLogger \Logger | | |

(") Database:

Source Mame: | Seﬁjng_l

<Back || mMext> | [ cancel |

4. If necessary, modify the name and order of Table Fields. Add <DATA_TYPE>, <SERVER_UTC_TIMESTAMP>,
etc., if they are required to be recorded into the database or spreadsheet, and then click Finish.

e
Data Field *Table Field Data Type w | |

<UNIT> <UNIT> String
<SOURCE_UTC_TIMESTA... <SOURCE_UTC_TIMESTA... **String
<SOURCE_TIMEZONE > <SOURCE_TIMEZONE > Float
<DATA_TYPE>

<SERVER_UTC_TIMESTA...
<SERVER_TIMEZOME >
<QUALITY >

OOoOE

*max, length =30; = * [ 1" are not allowed.
** option: DateTime or String

Automatically start recording when service starts running.

<o | ] [conn
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Getting Started

5. Click the Refresh button to get the latest MX-AOPC UA Server OPC tags.

[ mx-aopcua

File Server Logger Tools Runtime

TEHEBERSURG 008

(=P U Server Group

------- ﬁ Server1{192. 168.34.10:53192)

(-6 Logger Group List
-5 LoagerGroupl

L “YLogger1

Recording

Sart | [ stp |

|| Automatically start recording when service starts running

Tag Selection
[Serverl V] [AHDevice Vl@ I
Available Tags Tags
Tag Mame » Tag Mame
Server Mame  Tag Mame Description

Property
Type: Excel
Qutput:  C:\Users\PubliciDocumentsMoxaMXAOPCLogger\Logger\Logger1 20160327 191752 -]
Table: Loggerl

Data Field Table Field Data Type Order
<TAG_ID> <TAG_ID> String i
<VALUE> <VALLUE=> String 2
<UNIT = <LNIT > Siring 3
<50URCE_TIMESTAMP > <S0URCE_TIMESTAMP = DateTime 4

6. Click the appropriate arrow buttons to add items to or remove items from the Selected Tags list.

[ Mx-aoPCUA

File Server Logger Tools Runtime

TEAPERTEHRGO00SE

& n Server Group

Recording

st | | Stp |

[ Automatically start recording when service starts running

Tag Selection
[Sewerl v] [hﬂ Device V] @
Available Tags =Eelected Tags
Tag Mame - » Tag Name

& Server 00,Buzzer

% Server 00.Intrusion alarm
%% Server 00.Level Low

i Server 00.Level Normal

& Server 00,501-E1210.Pump
% Server 00 .SysConnect-00
% Server 00.5ysIPAddress
i Server 00,5ysMAC

m

% Server 00.flow S %5 Server 00.501-E1210.Cabinet

Server Name  Tag Mame Description |
Serverl % Server 00.Buzzer Desc -
Serverl % Server 00.Intrusion alarm Desc T
Serverl %% Server 00.Level Low Desc

Serverl % Server 00.Level Normal Desc -
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Starting Runtime Service

After connecting the MX-AOPC UA Server and creating the Logger, click the Start Runtime Service icon to
start running the MX-AOPC UA Logger service.

4 MX-AOPC UA

File Server Logger Tools Runtime Help
S [ — - . =
TEAFBPERSHKG|0O0&E
=5 B Server Group Rtz

ﬁ Server1(192.168.34,10:53192) | S == 1

] Automatically start recording when service starts running

i Server 00,501-E1210.Pump
“@ Server 00.5ysConnect-00

Tag Selection
(= H Logger Group List [Ser\rerl V] [.AH Device V] @
E‘ﬁ LoggerGroupl Available Tags Selected Tags
,i. Loggerl
Tag Mame = Tag Name

%4 Server 00.Buzzer
& Server 00.Intrusion alarm

% Server 00.Level Low
& Server 00.Level Normal

%% Server 00.5ysIPAddress
W Server 00,5ysMAC

o

& server 00, flow - & Server 00.501-E1210.Cabinet

Server Name  Tag Mame Description k=
Serverl % Server 00.Buzzer Desc -

Serverl ¥ Server 00.Intrusion alarm Desc 1

Serverl ‘@ Server 00.Level Low Desc B
Serverl “% Server 00.Level Normal Desc -

A green light next to the logger name indicates that the logger is ready to record.

AR U logger T .

File Server Logger Tools Runtime Help
TEAEERSHREGO008E

=5 ﬁ Server Group B
: ﬁ. Server1(192.158.34. 10:53192) 1
Start Stop |
[ Automatically start recording when service starts running
Tag Selection
- & Logger Group List | x| - | C|
Available Tags Selected Tags
Tag Name Tag Mame
Server Name  Tag Name Description B2
Serverl %% Server 00,Buzzer Desc -
Serverl % Server 00.Intrusion alarm Desc 1
Serverl ‘i’s\-‘ Server 00.Level Low Desc TS
Serverl % Server 00.Level Normal Desc -
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A yellow light next to the logger name indicates that the logger setting is not correct. Check the settings of the
logger, and then confirm the database or spreadsheet settings again.

1 MXCAQRC UA Logger T ————
Ei

le Server Logger Tools Runtime Help

e g,

TEREEBSHRE 008 E

= ﬁ Server Group Recording

Start Stop

Automatically start recording when service starts running

Tag Selection
&)
Available Tags Selected Tags
Tag Mame » Tag Mame
4
4
“
Server Name  Tag Name Description

You will not be allowed to modify the server connection and logger settings when runtime service is running. To
stop runtime service, click the Stop Runtime Service icon.

MX-AOPC UA Logger
e

B
Eil

Server Logger Tools Runtime Help

EHEERSUR GO0

= ﬁ Server Group Recording
e E Server1{192.168.34.10:53192)
Automatically start recording when service starts running
Tag Selection
=8 Logger Group List ]
E‘E LoggerGroup 1 Available Tags Selected Tags
;Q Loggerl

Tag Mame | Tag Mame
>
4
L]

Server Mame  Tag Mame Description =

Serverl "'Q' Server 00.Buzzer Desc =

Serverl % Server 00.Intrusion alarm Desc T

Serverl %% Server 00.Level Low Desc

Serverl & server 00.Level Normal Desc -

NOTE Configuration changes will be updated to Logger’s runtime service after the runtime service is started. If the
runtime service is not started, any change will be discarded when the configuration console is closed. Be sure
to save your project file when you close the configuration console.
NOTE

Stopping Runtime Service will stop both the logger recording and data supplement functions, which may cause
data loss.
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Starting Recording

To start recording data, click the logger icon and then click the Start Recording icon to start recording the
selected tags into the database or spreadsheet.

O U ogger T I

File Server Logger Tools Runtime Help

ol B

=2 U Server Group Recredng
5 Server1(192.168.34. 10:53192)
"Ta utomahcally start recording when service starts running
E T Tag Selection
= l:_( LoggerGroulest - | v| | v' |G|
L Available Tags Selected Tags
Tag Mame | W | Tag Name
(SR I
(<]
[« ]
Server Name  Tag Name Description | 5=
Serverl W Server 00.Buzzer Desc i
Serverl W Server 00.Intrusion alarm Desc T
Serverl W Server 00.Level Low Desc
Serverl W Server 00.Level Normal Desc -

A red light next to the logger indicates that the logger is recording.

© MX-AOPC UA Logger 1 —

File Server Logger Tools Runtime Help

O .

(= ‘ Server Group
------- B Server1(192.168.12.112:53192)

B- H Logger Gruup List
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Click the folder icon to check if data is being recorded into the target spreadsheet.

H MXAGPCUALogger e o s
File

Server Logger Toels Runtime Help

NEEEEBRTERA00SS

& ﬁ Server Group Recarding
L B} Server1(192,1568. 34, 10:53192)
Start Stop
Automatically start recording when service starts running
Tag Selection
E-E Logger Group List c
=& LoggerGroup1 Available Tags Selected Tags
Loggerl =

Tag Mame oot Tag Mame
P
4
et

Server Mame  Tag Name Description 2+

Serverl % server 00,Buzzer Desc L

Serverl %y Server 00.Intrusion alarm Desc 1

Serverl “‘9‘ Server 00.Level Low Desc T

Serverl % server 00.Level Normal Desc -

Property
Type: Excel
Output:  C:\Users\Public\Documents \Moxa WMXAOPCLogger \Logger\Loggerl 20160327 191752 -II
NOTE Be sure to close the target spreadsheet listed in the target root path before starting to record. If the target

spreadsheet is open, the MX-AOPC UA Logger will not be able to record data to the target file.

NOTE DO NOT open the spreadsheet while recording is under way. Doing so will cause the spreadsheet file to become
corrupted because it is in use by the MX-AOPC UA Logger service. To open the spreadsheet, stop the MX-AOPC
UA Logger’s runtime service and then click the folder icon to access the file.

Testing the Data Supplement Function

Take the following steps to test the data supplement function.

1. Insert a microSD card into your Moxa device.

2. Use IOxpress to configure the Moxa device to allocate data buffer size for network failure and to enable
connection to the MX-AOPC UA Server.

Setting | Click&Go Plus Click&Go Plus Simulator Peer-to-Peer _

= System |
(= Security [ Enable connection to AOPC Server with heartbeatinterval 5 secfs)
= Metwork
B0 Server Mode
4 SNMP
= Modbus @) Single Server 1st AOPC Server 192 . 168 . 12 . 112
= = AOPC |
[~ 8 serveComecton ||
= Tag Selection I
(= Serial Port
= Data Logging ) Failover
= Click&Go Plus

~) Dual Server

[

SECiS)

Data buffer for network failure

Maximum size (512 to 32768 MB) 1024
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Select the checkboxes of the tags associated with the data you would like the MX-AOPC UA Server to
update.

Setting Click&Go Plus | Click&Go Plus Simulator | Peer-to-Peer _
= System
S Seartty Select Modie: Al v| [ selectAl || unselectal || Appiytoal |
: rI\I‘thwcrk 1O Type [M
= SHMP Slot Mo, Channel Mo, Description 0On Change Perc
= Modbus
0 Desc Disabled 50
1 Desc Disabled 50
2 Desc Disabled 50
3 Desc Disabled 50
= Data Logging
= Click&Go Plus

If the cellular device’s SIM card uses a private or dynamic IP address, enable the Cellular Data Access
function. If the SIM card is using a public IP address, continue with step 5.

.
£ System ) )
5 General VPN Reconnection Port Forwarding DDNS Cellular Data Access
= Security
Bl & Network
£ General Enable Cellular Data Access ]
=i LAN
i Celliar IPAddress | 192 . 168 . 12 . 113
=10
SHMP
5 Modbus Port 3401
=
=1 ADPC <
= Serial Port Unigue ID 0
= Data Logging ]
= Click&Go Plus Heartbeat 30

Update the device’s configuration.

e Moxa IOxpress - C:
Project Device Configuration Online Device Options  Help

=32542-H5PA - 192, 168.12,230

SelectFuncﬁon[Update Configuration to Device v] [ Select Al ] [ Unselect All ] [ Apply to Al ]

Overwrite Network Setting

MNo. Server Name Model (Cellular) IP Address MAC Address Configure De

F o ioLogik 2542 Demo Kit 2542-HSPA 192.168.12.230 00-90-E8-46FB-BE ioLogik 25421

Conduct a Time Sync on the device to ensure that the device, MX-AOPC UA Server, and MX-AOPC UA
Logger are time synchronized.

e Moxa [Oxpress - C:\Users\Public\Documents\Moxa\IOs
Project Device Configuration  Online Device Options  Help

= 2542-H5PA - 192,168.12.230
Select Function [Tlrne Sync v] [ Select Al ] [ Unselect Al ] [ Apply to All ]
@ Sync with PC () Manual Setting Date: 2016/ 5/ 5 Time: 13:13:21 & (UTC)
No. Server Name Model (Cellular) IP Address Lock/Unlock
a ioLogik 2542 Demo Kit 2542-HSPA 192.168.12.230 Unlock
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7.

If Cellular Data Access software is required, enable the MX-AOPC UA Logger’s Data supplement through

Cellular Data Access option at Tools © Data Supplement Settings. If Cellular Data Access software is
not required, continue with step 8.

ousppemert et S

Data supplement after network reconnection

Retry Tmeout 30 sec(s) (5 to 600, default: 30)

Retries 3 {0 to 10, default: 3)

Data supplement through Cellular Data Access

IP Address 192 . 158 . 12 . 112

Port 9400 {0 to 65535, default: 9400)

Folder for supplementary data

Path  C:\Users\PubliciDocuments\Moxa MEXAOPCL E]

8. Ensure that the logger is in recording mode.

Eile Server Logger Tools Runtime Help

NMEmEERPSERT0CO0SSE

=l - Server Group R

e n Server1(192, 168,12, 112:53192) | Start | [ Stop ]

[ ] Automatically start recording when service starts running

Tag Selection
-6 Logger Group List | = ) E
Elﬁ LoggerGroup1 Available Tags =
..... P YLogger1 | —— L » ||
> |
[ a1
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9. Disconnect the Ethernet connection between the Moxa device and the MX-AOPC UA Server. Wait longer
than the heartbeat interval (the ioLogik 2500’s default heartbeat interval is 30 sec.) plus the heartbeat
tolerance (the MX-AOPC UA Server’s default heartbeat tolerance is 30 sec.), and then check if the tag status
is “Disconnected” on the MX-AOPC UA Viewer. If it is disconnected, wait longer than the update interval of
the tags, and then reconnect the connection between the Moxa device and MX-AOPC UA Server.

MX-AOPC UA Viewer EEEEE )
File Tools Help
h Active Device List TagMame  Description Data Type Value Device timestamp (UTC) Time Zone  AccessRights | Quality pdate Count
1 pac-01 (00:90:e8:21:4a:ea) - x . l
B E224201 (00:20:68: 15:27: 15) ‘@ ioLogk ... Desc Boolean 0 06:01:37.000 2016/04/25  UTC+8 Read fWrite Disconnected &
i 1 iologik 2542 Demo Kit (00:30:28:4 i’ﬂ} ioLogk ... Desc Float 2,531 06:28:32,000 2016/04/25  UTC+8 Read-only Disconnected 1938 I
1% Modbus Device Group List “Piologk ... Desc Boalean [1] 06:01:37.000 2016/04/25  UTC+8 ReadfWrite Disconnected |4
“iologk ... Desc Boalean 1 06:01:37.000 2016/04/25  UTC+8 Read/Write Disconnected 17
“iologk ... Desc Boolean 0 06:01:37.000 2016/04/25  UTC+8 Read/Write Disconnected |37
“iologk ... Desc Float 10.000  06:28:32.000 2016/04/25  UTC+8 Read-only Disconnected  §1933
“iologk ... Desc Boolean 0 06:01:37.000 2016/04/25  UTC+8 Read Write Disconnected
“ioLogk ... Desc Boolean 0 06:01:37.000 2016/04/25  UTC+8 Read-only Disconnected |4
& ioLogk ... Desc Boolean 0 06:01:37.000 2016/04/25  UTC+8 Read-only Disconnected
“iologk ... System Conn... Boolean 0 06:28:42,629 2016/04/25  UTC+8 Read-only Good 4
“Yiologk ... DeviceIP Ad... String 192,16,,, 06:28:42.629 2016/04/25 UTC+8 Read-only Disconnected |4
“Fiologk ... Device MAC ... String 00:90:,,, 06:28:42,629 2016/04/25 UTC+8 Read-only Disconnected r
L] ] 3l H n |
Date Time Event =
2016/04/25 14:29:35 The tag DAC-01.AI-03 changes the value from 0.000 to 0.001 D
2016/04/25 14:28:35 The tag DAC-01.AT-02 changes the value from 0.001 to 0.001
2016/04/25 14:28:35 The tag DAC-01. AI-01 changes the value from -0.000 to 0.000
2016/04/25 14:28:35 The tag DAC-01.AI-00 changes the value from 0.000 to 0.000
2016/04/25 14:29:34 The tag DAC-01.AI-03 changes the value from 0.001 to 0,000
2016/04/25 14:29:34 The tag DAC-01,AI-02 changes the value from 0.001 to 0.001
2016/04/25 14:29:33 The tag DAC-01,AI-03 changes the value from 0.000 to 0,001
2016/04/25 14:29:33 The tag DAC-01.AI-01 changes the value from 0.000 to -0.000
2016/04/25 14:29:32 The tag DAC-01.AI-01 changes the value from -0.000 to 0.000
2016/04/25 14:29:31 The tag DAC-01.AT-03 changes the value from 0.001 to 0.000
2016/04/25 14:29:31 The tag DAC-01.AI-02 changes the value from 0.001 to 0.001
Anicinaine 44,7031 The fma DAS A AT A1 dhamnnn Hom imliim Frmee 0 AAA 4a AOAR =t
< n | b

Ready Time: 14:28:35

10. The pink and gray flashing light indicates that the logger is performing the data supplement process.

,
PEZCET e

File Server Logger Tools Runtime Help

NEFCERSERGTO0SE

(= ﬁ Server Group

Recording
[ st | [Loswe ]

Tag Selection
=& Logger Group List | 1r| . =
EIE Eoage G Available Tags
i ﬁ Logger 1 ST IL
>
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11. After the data supplement process is complete, the light will change to red. The event log will show how long
the data supplement process took to perform, and the result of the supplement process.
{ MX-AOPC UA Logger
_Elle Server Loggel__ Tools Runtime Help )
TEHEEBRSEHRG 008 d
B . Server Group T =
‘ Server1(192.168.12,112:53197)
[ sttt | [_swp
[ Automatically start recording when service starts running
Tag Selection
EB Logger Group List | v| | V| |E| =
E‘@ a?gerGroupl Available Tags Selected Tags
..... Logger1
Tag Mame | » | Tag Mame
[» ]
(<]
[«] §
Server Name  Tag Mame Description
Serverl L ioLogik 2542 Demo Kit.Pressure Desc
Date Time Event 3
2016/05/06 11:45:41 Finished retrieving log [from 2016/05/06 03:44:05 to 2016/05/06 03:44:27] from the device [MAC:00-90-e8-46-fb-be].
2016/05/06 11:45:41 LoggerGroup1.Logger1: supplement data is saved to C:\Users\Public\Documents\Moxa\MXAOPCLogger\Logger\Logger1_20160506_113¢]
2016/05/06 11:45:39 Retrieving log 1/1 [from 2016/05/06 03:44:05 to 2016/05/06 03:44:27] from the device [MAC:00-90-e8-46-fb-be]
2016/05/06 11:45:37 Connecting to the device [MAC:00-90-e8-46-fb-be] for retrieving log from 2016/05/06 03:44:05 to 2016/05/06 03:44:27...
2016/05/06 TTa5:41 Tecor: ogg 1
2016/05/06 11:43:37 LoggerGroupl.Logger 1 sucessfully connected to database!
2016/05/06 11:43:36 MX-AOPC UA Logger runtime service is running.
2016/05/06 11:43:35 Initializing database...
MN1AMEMNA 11:4%1A MY¥-AMDE 1 1A | nnner rintime service ie ctan 2l
< N0 » v
Service Status : Running Time: 11:45:45
12. Open the database folder and note which files the supplementary data has been saved to.

b e e
s

Organize «

@ Open =

Share with = Print E-mail Mew folder

q r Favorites Date modi
I

Bl Desktop 2016/4/25°

& Downloads Ei 2016/4/25

"2l Recent Places
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Configuration Console

The following topics are covered in this chapter:

O Main Screen Overview
O Menu Items
» File
Server
Logger
Tools

Runtime

vV V VYV V V

Help



MX-AOPC UA Logger

Configuration Console

Main Screen Overview

The MX-AOPC UA Logger’s configuration console displays settings for connected MX-AOPC UA Servers and

loggers. It also shows the logger runtime status.

Logger Tools Runtime Help

.
- MX-AOPC UA Logge

File Server

LEE B

CEBRSHRE00HE

=5 ﬁ Server Group Reeehn =~
------- B Server1(192.168.12.112:53192) 6
Start Stop
4 [ Automatically start recording when service starts running
Tag Selection
- H Logger Group List [Serverl v] [AJI Device v] =
&- i] ‘LGO?QEFGFOUN Available Tags Selected Tags
Logger1
Tag Name . » Tag Mame
L ioLogik 2542 Demo Kit.501-E1210.Pumr E L ioLogik 2542 Demo Kit.Pressure
i il ogik 2542 Demo Kit. SysConnect-00 E
& ioLogik 2542 Dema Kit, SysIPAddress I:I | 4
5 W ioLogik 2542 Demo Kit.5ysMAC - E
4 n ]
Server Mame  Tag Mame Description
Serverl "€S‘u‘ ioLogik 2542 Demo Kit.Pressure Desc
Date Time Event &
2016/05/06 11:48:07 MX-AOPC UA Logger runtime service is stop.
2018/05/06 11:45:41 Finished retrieving log [from 2016/05/06 03:44:05 to 2016/05/06 03:44:27] from the device [MAC:00-90-e8-46-fb-be]. =
2016/05/06 11:45:41 LoggerGroup1.Logger 1: supplement data is saved to C:YUsers\Public\DocumentsMoxa\MXAOPCLogger \Logger \Logger 1_20160506 113':
2016/05/06 11:45:39 Retrieving log 1/1 [from 2016/05/06 03:44:05 to 2016/05/06 03:44:27] from the device [MAC:00-90-e8-46-fb-be]
2018/05/06 11:45:37 Connecting to the device [MAC:00-90-8-46-fb-be] for retrieving log from 2016/05/06 03:44:05 to 2016/05/06 03:44:27...
2016/05/06 11:43:41 Start recording logger ‘Logger1'
2016/05/06 11:43:37 LoggerGroup1.Logger 1 sucessfully connected to database! 7
2016/05/06 11:43:36 MX-AOPC UA Logger runtime service is running.
NIAMGINA 11.4%.35 Tritializinn Aatahace L

4

i |

Service Status : Stopped 8

Time:11:4831 9

No. Zone Description

1 Software Title Displays the name of the software: MX-AOPC UA Logger

2 Menu Bar All configuration functions can be accessed from these menu items
3 Quick Launch Bar Frequently used icons

4 Server View All MX-AOPC UA Servers

5 Logger View All Loggers

6 Detailed View Detailed settings of the servers and loggers

7 Log View Logger Runtime logs

8 Runtime Service Status | Indicates if the logger runtime service is Running or Stopped

9 Logger Time Displays the Logger time (same as the PC’s time)
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Menu ltems

File

Use the File menu to manage project files.

24 MX-AOPC UA Logger - D:kfﬂﬂemk_cheniﬂm:malm_
[Eile] Server Logger Tools Runtime Help

Mew Ctrl+M ;! ﬁ
Ctrl+ 0 -

Open..

Save Ctrl+5

Save As...

1 AOPC_Loggers.aog

2 A0OPC_Loggerd.acg .

3 AOPC_Logger3.aoqg
4 AOPC_Logger2.aog
5 AOPC_Loggerl.acg

Exit

= New: Create a new project file.

= Open: Open an existing project file.

= Save: Save the current project.

= Save As: Save the current project file as another project with a different filename.
= Previous saved files: Quickly open previously saved project files.

= Exit: Close the Configuration Console.
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Server

Use the Server menu to edit MX-AOPC UA Server connection settings.

£ wxa0vc U Logg A

File [Sewer] Logger Tools Runtime Help

- Discovery % ﬁ EE_} é_j a; ll:
] Connect i : -
& Disconnect

Delete 112:53192)

Properties

= §:i' Logger Group List

= Discovery: Discover MX-AOPC UA Servers and configure its connection settings.
= Connect: Connect the selected server.

= Disconnect: Disconnect the selected server.

= Delete: Delete the selected server.

= Properties: Modify the settings of the selected server.

NOTE

The properties of a server cannot be modified either when the server is in connecting mode, or runtime service
is in running mode. Stop runtime service and disconnect the server connection before modifying the server

properties.
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Logger

Use the Logger menu to edit logger settings.

i MX-AOPC UA Logger NN

File Server |Logger| Tools Runtime Help

Mew Logger Group l':" ég ‘

Mew Logger
- ﬂ Sery Delete

r'_
!

Start Recording
Stop Recording

Properties

=8 = §l ogger Group List
B

New Logger Group: Create a new logger group.

New Logger: Create a new logger.

Delete: Delete the selected logger.

Start Recording: Start recording for a selected logger group or a selected logger.

Stop Recording: Stop recording for a selected logger group or a selected logger.

Properties: Modify the settings of an existing logger.

NOTE The properties of a logger cannot be modified either when the logger is in recording mode, or runtime service
is in running mode. Stop runtime service before modifying logger properties.

Tools

Use the Tools menu to configure data supplement settings, for certificate management, to access a system log,
to change a password, or to modify console environment settings.

& MX-A0PC UA Logger NN

File Server Logger E Tools | Runtime Help
e Data Supplement Settings | \@
LHN B

= ﬂ Server Group

Certificate Management

System Log r
Change Password

Options
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Data Supplement Settings

Data supplement after network reconnection
Retry Tmeout 30 sec(s) (5 to 600, default: 30)
Retries 3 {0 to 10, default: 3)
[ Data supplement through Cellular Data Access

IP Address BEE e )

Port |3400 {0 to 65535, default: 9400)

Folder for supplementary data

Path C:Wsers\Public\DocumentsMoxa MEADPCL E]

[ K ][ Cancel ]

Data supplement after network reconnection: Enable this function if the Moxa products connected
to an MX-AOPC UA Server support the data supplement function.

. Retry Timeout: The retry timeout interval for retrieving supplementary data from a device’s
buffer.

. Retries: The number of retries allowed after a retry timeout.

Data supplement through Cellular Data Access: Enable this function if the Moxa products
connected to the Cellular Data Access software support the data supplement function.

. IP Address: The IP address of the Cellular Data Access software.
. Port: The listen port of the Cellular Data Access software.
Folder for supplementary data

. Path: The folder path to which the system can temporarily save supplementary data. Delete the
supplementary data files after the data is supplemented into the database.
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* Certificate Management

If the security policy of the MX-AOPC UA Server is set to Basic128Rsal5: Sign, Basic1l28Rsal5: Sign
and Encrypt, or both, importing an OPC UA client’s CA (Certificate Authority) file into the MX-AOPC UA
Server, and exporting the MX-AOPC UA Server’s CA file to OPC UA Clients are both required.

Click the Trust Servers tab, click Import, and select the server’s CA file to import it into the MX-AOPC UA
Logger.

Trust Servers | Instance Certiﬁr.ztes|
Server Mame LRI
v MX-AQPC LA Server urn: CHARLESCHEM-ME:MxX-AQPC LA Server
1 | 1 | b
[ Import... ] i Export... i | Remove i i Trust i i View Certificate... |




MX-AOPC UA Logger Configuration Console

Click the Instance Certificates tab and click Export Logger Certificate to export the MX-AOPC UA
Logger’s CA file to OPC UA Server.

Trust Servers | Instance Certificates |

[ View Logger Certificate. .. | certificate MX-AOPC UA Logger is from
2016/4/14 L9 05:38:38 to 2021/3/19
_tF 06:38:38

[ Export Logger Certificate. .. ]

i Reissue Certificate ]

NOTE After reissuing certificates or re-installing the MX-AOPC UA Logger, you will need to export the Logger
Certificate to the OPC UA Server again.

= System Log

1 WixA0PC U Looo T

File Server Logger | Tools | Runtime Help

f— @ e Data Supplement Settings ] a @ 6 ii E
e - Certificate Management ; :
|
& Server Grou
ﬁ g System Log ] Save to Text File

Change Password Reset System fog

Options !
= & e |

» Save to Text File: Save the MX-AOPC UA Logger’s system log to a text file. You will be required to enter

System Log Settings

a password (default password = moxa).

Verify Password . u

Please enter password;:

| o J[ concel ]|
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» Reset System Log: Reset the MX-AOPC UA Logger’s system log. You will be required to enter a
password (default password = moxa).

MX-AOPC UA Logger ‘ [ ]

Verify Password u
5 =

% Do youwant to reset system log?
é Y . g Pleaze enter password:

| Y || Mo [

K J [ Cancel

» System Log Settings: Defines the maximum number of records that can be saved in the MX-AOPC UA
Logger’s system log (values can range from 1 to 30000; the default value is 30000).

System Log Settings - u

Event Records: 30000

(1~30000)

| ok || cancel |

Change Password: Change the MX-AOPC UA Logger’s system password. The password is required when
updating configurations to System Runtime, saving system logs to a text file, or resetting the system log
(length: 4 to 128; acceptable characters: A to Z, a to z, O to 9, Symbols; default: moxa).

COld Password:

Mew Password:

Confirm Password;

[ ok || cancel |

Options: Configure environment settings for the MX-AOPC UA Logger’s configuration console.

v

Configuration File

Automatically save configuration every 10 min(s) (1 to 30, default: 10)

Automatically save configuration before exiting this console

[ Ok, ] [ Cancel

NOTE If Automatically save configuration every xx min(s) is enabled, the configuration file will be automatically

saved only when a filename is defined. Be sure to save your configuration file after creating a new project file.
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Runtime

Use the Runtime menu to Start, Stop, or Reinitialize Server Runtime Service.

i MX-AOPC UA Logger I

File Server Logger Tools Iﬂunﬁme Help

- _. e ‘ ﬁ Start Runtime Service ﬂ

B Stop Runtime Service

& ﬂ Server Group Reinitialize Runtime Service
------- ﬁ Server1(192, 168, 12 TTZ53197) |

Help

Use the Help menu to launch the Logger’s help documentation, to check the Logger’s license status, to add a
license file, or to check the logger version.

T E——

File Server Logger Tools Runtime

—_— —- e ﬁ E ﬁ LﬂggerHeIp

Licensing

- ﬁ Server Group About...
------- B server1(192.168.12.112:53192) I

Start

= Logger Help: Launch the MX-AOPC UA Logger’s help documentation.

= Licensing

T S —————

File Server Logger Tools Runtime!

r— —. - ﬁ ﬂ j LoggerHeIp Ny =

Licensing r License Info

= a Server Group About... Add License File
------- B Server1(192.168.12.112:53192) ‘ |

Deactivate License

Start

» License Info: Displays the Logger’s User Code, License Status, and the Time Remaining on the license.
Refer to License Registration and Activation to learn how to activate the license.

e e

User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1
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» Add License File: Import a license file after completing the license registration process. Refer to
License Registration and Activation to learn how to activate the license.

» Deactivate License: Deactivate the current license version and load factory default settings. Note that
when you deactivate the license, your license file and runtime configurations will be deleted. Be sure to
back up your runtime configurations before executing a license deactivation procedure.

= About: Displays the MX-AOPC UA Logger’s version number and build number.

Mg
Moxa MX-ACPC UA Logger 1.0 build 16040813
|

%’ Copyright (C) 2016 Moxa Inc,
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Server Management

The following topics are covered in this chapter:

O Server Discovery
» Getting the Server Endpoint from an MX-AOPC UA Server
» Discovering MX-AOPC UA Servers
O Server Connection
» Connecting to the discovered MX-AOPC UA Server
» Editing the connection settings of the discovered MX-AOPC UA Server
» Deleting the connection settings of the discovered MX-AOPC UA Server
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Server Discovery

In this section we explain how to discover an MX-AOPC UA Server.

An MX-AOPC UA Logger can discover MX-AOPC UA Servers installed on a local or remote computer. First, get
the server endpoint, and then follow the onscreen instructions to discover the server. After the server has been

discovered, be sure to connect to the server before adding the tags into loggers for recording.

NOTE

The server discovery or server connection settings can only be configured when runtime service status
is stopped. To stop the runtime, click the stop runtime icon on the quick launch bar.

Getting the Server Endpoint from an MX-AOPC UA Server

1. Open the MX-AOPC UA Server configuration console by clicking Tools > OPC UA Settings - Server

Endpoint Settings. Be sure the status of the Server Endpoint is valid, and then copy the Server Endpoint of
the MX-AOPC UA Server.

Server Endpoints Settings s

URL Status
opc.top:ff192, 168, 12, 112:53192/MXACPC JUAServer Walid

Metwork Interface: |InteI{R} Ethernet Connection {3) I2181M -

Port Mumber: 53192

opc.top: /192,168, 12, 112: 53192 /MY AQPC /JUAServer

I Add I I Delete | | Apply I [ Close

2. Goto Tools - OPC UA Settings = Security Policy Setting and confirm the MX-AOPC UA Server’s security

policy settings. The security policy is applied to connections between OPC UA clients and the MX-AOPC UA
Server. If Basic128Rsal5: Sign, Basic128Rsal5: Sign and Encrypt, or both of these options are selected, you
will need to configure Certificates Management settings on both MX-AOPC UA Server (Tools - OPC UA
Settings 2 Certificates Management) and MX-AOPC UA Logger (Tools - Certificate Management). If
only “None” is selected, you only need to know the password of the MX-AOPC UA Server.

Security Policy Setting [ S|

MNone
[| Basic128Rsa15 - Sign

[ Basic128R=a15 - Sign and Encrypt

Ok ] [ Cancel
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Discovering MX-AOPC UA Servers

1. Go to the MX-AOPC UA Logger, right click a Server Group and then click Discovery in the pop up menu, or
click the Server Group to select it and then click the Discovery icon on the quick launch toolbar to start
discovering MX-AOPC UA Servers.

, e

Eile Server Logger Tools Runtime Help

ERESSRG008S

2. Select Local Server if the MX-AOPC UA Server and MX-AOPC UA Logger are installed on the same computer,
or click Remote Server Endpoint and type in the target Server Endpoint. Next, type in the password of the
MX-AOPC UA Server, and then click the Next button.

vcnrysner | ==

@ Local Server

| ope. tep://192. 168. 12. 112:53192/MXAOPC/UAServer -

") Remaote Server Endpoint

Password L Ll

| <Back || Next> | [ cancel
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3. Modify Server Name, and configure Security Policy and Security Mode to be the same as the MX-AOPC
UA Server’s UA Settings. If necessary, update the Publish Interval, Sampling Interval, Queue Size, or
Discard Oldest settings, and then click Finish.

Discovery Server LX)

Server Mame  Serverl {max. length = 30; ™. is not allowed)

Server Endpoint:  opc.top: /192, 168. 12, 112: 53192 MXAOQPC fUASErvEr

Security Policy [Nnne - ]

Security Mode INnne - I

Subscription Settings

Publich Interval O = ms (0 to 85400000, default: 1000)
Keep Alive Count 10
Lifetime Count 1000
Maonitored Item Settings

Sampling Interval 500 : me (-1 to 86400000, default: 500)

Queue Size 10 (0 to 10000, default: 10)

Discard Oldest  [¥/]

< Back H Finish ][ Cancel

» Server Name: Give a name for the connection of the MX-AOPC UA Server (max. length = 30; a period
“.” is not allowed). The server name should be unique and cannot be modified after you click Finish.

Server Endpoint: The server endpoint of the discovered MX-AOPC UA Server.
Security Policy: Configure the same security policy as the MX-AOPC UA Server.

Security Mode: Configure the same security mode as the MX-AOPC UA Server.

YV V VY V

Subscription Settings: Configure the subscription settings for MX-AOPC UA Logger to receive OPC tag

data from the MX-AOPC UA Server.

. Publish Interval: The publish interval defines the rate at which the Server sends OPC tag data to
the Logger (unit: ms; values: 0 to 86400000; default: 1000; O: the fastest practical rate).

. Keep Alive Count: The keep alive count defines the number of publish intervals that must expire
before a keep alive message is sent.

. Lifetime Count: The lifetime count defines the number of times of publish interval can expire
without the MX-AOPC UA Logger sending data updates or keep alive messages before the server
deletes the subscription.

» Monitored Item Settings

. Sampling Interval: The sampling interval defines the rate at which the server checks for changes
in the monitored device readings (unit: ms; values: -1 to 86400000; default: 500; the default
interval set by the server: -1; the fastest practical rate: 0).

. Queue Size: The queue size defines the number of data updates that the OPC UA Server will queue
for the subscription
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L] Discard Oldest: The discard oldest defines the discard policy of the queue. When checked, the
oldest notification in the queue will be discarded and will not be sent to the MX-AOPC UA Logger.
When unchecked, the newest notification will be discarded and will not be sent to the MX-AOPC UA

Logger (default setting: enabled).

Server Connection

In this section we explain how to connect to the discovered MX-AOPC UA Server, and how to modify the

connection settings.

Connecting to the discovered MX-AOPC UA Server

Before configuring the logger, you must first connect to the discovered MX-AOPC UA Server to get the OPC tag

list from the servers.

Ensure the runtime service is stop.
Right click the server and click Connect in the pop up menu, or click the server to select it and then click
the Connect icon on the quick launch toolbar. The server should now be connected to the MX-AOPC UA
Logger.

I e e )

TEF BERSHR G008

=3 B Server Group
Server1(192.168,12.112:53192)

rver Endpoint: opc. tep: (192, 168, 12, 112:53192/MXAOPC /JUAServer
Connect
Dot Security Policy: Mone
Delete |Security Mode: Mone
L G List 5
e Eif Ogger laroup Lis Properties o . i X
= ﬁ LoggerGroupl bscription Settings Monitored Item Settings
Q Loggerl
Publish Interval: 1000 Sampling Interval: 500
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
Date Time Event
2018/05/06 14:42:35 Server 1 disconnect!
2018/05/06 14:42:15 MX-AOPC UA Logger runtime service is stop,
< | 1 2

Service Status : Stopped Time: 14:43:40

" o =T
File Server Logger Tools Runtime Help

T — —— —— - . - = =
TEEPERSEHKGO0S S

Bﬁ Server Group

i ﬁ Server1(192.168.12.112:53192) Server Endpoint:  opc.top:/f192. 168, 12, 112:53192/MXACPC/UAServer

Security Policy: Mone
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Editing the connection settings of the discovered MX-AOPC UA

Server

Take the following steps to edit the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.
2. Right click the server and click Disconnect in the pop up menu, or click the server to select it and then click
the Disconnect icon on the quick launch toolbar.
TP e st
File Server Logger Tools Runtime Help
rEReEEESRG008E
BB Server Group
Ei ﬁ Server1(192. 168.12,112:53197)

Server Endpoint: opc. tep: 192, 168, 12, 112:53192/MXAOPC /JUAServer

Connect
- ecurity Policy:  MNone
Disconnect S Eoky
Delete ecurity Mode: Mone
=& Logger Group List )
(-8 LoggerGroup1 il cription Settings Monitored Item Settings
ﬁ Loggerl
Publish Interval: 1000 Sampling Interval: 500
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
Date Time Event
2018/05/06 14:50:08 Connect to Server1 success!
2018/05/06 14:42:35 Server 1 disconnect!
2018/05/06 14:42:15 MX-ACPC UA Logger runtime service is stop.
eHf m +

Service Status : Stopped Time: 14:50:26

3. Right click the server and click Properties in the pop up menu, or click the server to select it and then click
the Properties icon on the quick launch toolbar. Follow the onscreen instructions to edit the settings.

-
s R
Eile Server Logger JTools Runtime Help

ST e — —— —— 3 = e . 3
TEABPERSE SRG 0058 &

= ﬂ Server Group
Serveri(192.168.12.112:53192)

Server Endpoint: opc. bop: ({192, 168. 12, 112: 53192 MYXACPCA

Connect
Dbzt Security Policy:  Mone
Delete Security Mode:  Mone
- &4 Logger Group List p =
e bscription Settings Monitore
Publish Interval: 1000 Sampli
NOTE The server name cannot be modified after the initial setting. To change the server name, delete the original

server settings and then use the server discovery process to create a new one. Note that deleting the server
connection settings will delete all of the related logger settings at the same time.
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Deleting the connection settings of the discovered MX-AOPC
UA Server

Take the following steps to delete the connection settings of the discovered MX-AOPC UA Server:

1. Ensure the runtime service is stopped.

2. Right click the server and click Delete in the popup menu, or click the server to select it and then click the
Delete icon on the quick launch toolbar.

File Server Logger Tools Runtime Help

reseeesSR@o0os s

=5 ‘ Server Group

"""" Server1(192.168.12.112:53192) Server Endpgint:  opc.top: /192, 168. 12, 112:53192/MXACPC/UAServer
Connect
Disconnect [l e
Delete fode:  Mone
L G List :
e 521 SEgE S Properties % : :
(- LoggerGroup1 ettings Monitored Item Settings
@ Loggerl
Publish Interval: 1000 Sampling Interval: 500
Keep Alive Count: 10 Queue Size: 10
Lifetime Count: 1000 Discard Oldest:  Yes
Date Time Event
2018/05/06 14:52:40 Server 1 disconnect!
20160508 14:50:08 Connect to Server 1 success!
2018/05/06 14:42:35 Server 1 disconnect!
2018/05/06 14:42:15 MX-AOPC UA Logger runtime service is stop.
< T b

| Service Status : Stopped Time: 14:52:46

3. Click OK to confirm that you would like to delete logger settings at the same time.
weaorcun ooser N =

Deleting this server endpoint will delete all of the related logger settings at the
same time. Do you want to delete this server endpoint?

| ok || Cancel
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The following topics are covered in this chapter:

O Logger Group
» Adding a Logger Group to a Logger Group List
» Editing a Logger Group
» Deleting a Logger Group
O Loggers
» Adding a Logger to a Tag Group
» Editing a Logger
» Deleting a Logger
O Logger Recording
» Select Tags for Recording
» Start or Stop Recording
» Logger Status
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Logger Group

In this section we explain how to use the configuration console to add, edit, and delete logger groups.

Adding a Logger Group to a Logger Group List

Ensure that the runtime service is stopped.

2. Right click the Logger Group List and then click New Logger Group in the popup menu, or click the Logger
Group List to select it and then click the New Tag Group icon on the Quick Launch toolbar.

T ST

File Server Logger Tools Runtime Help

TEEBEEBREEKG 0088

(=5 B Server Group

MNew Logger Group

Start Recording

Stop Recording

Date Time Event

2018/05/06 16:19:09 Connect to Serverl success!

20160508 14:52:40 Server1 disconnect!

2018/05/06 14:50:08 Connect to Serverl success!

2018/05/06 14:42:35 Server 1 disconnect!

2018/05/06 14:42:15 MX-ACPC UA Logger runtime service is stop.

4 [l 3

Service Status : Stopped Tirme: 16:19:20

3. Type in the name of the logger group (max. length = 30 characters; “.” is not allowed) and then click OK.
Logger Group Pmpe__ LX)

Logger Group MName LoggerGroupl

{max. length = 30; ."is not allowed)

o | [ concel |
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4. The new logger group will be added to the Logger Group List.

ra ™ ——
4 MX-AOPC UA Logger

File Server logger Tools Runtime Help

E‘”\ﬂﬂﬂlﬁ&@\@@@@

= . Server Group Logger Name Output
------- ‘ Server1{192.168.12.112:53192)

= H Logger Group List

B ooercow

Editing a Logger Group

Right click the logger group and then click Properties in the popup menu, or click the logger group to select
it and then click the Properties icon on the Quick Launch toolbar.

f "
B4 MX-AOPC UA Logger

File Server Logger Tools Runtime Help

(=2 ' Server Group Logger Mame Output
------- ‘ Server1{192.168.12.112:53193)

= li Logger Group List

i =] LoggerGroup

Mew Logger
Delete

Start Recording
Stop Recording

Properties
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Deleting a Logger Group

Right click the logger group and then click Delete in the popup menu, or click the logger group to select it and
then click the Delete icon on the Quick Launch toolbar.

, oo e
e

File 3erver Logger Tools Runtime Help

II.l

- ' Server Group Logger Mame Output
------- B Server1(192.168.12.112:53192)

o L

= i:] Logger Group List
e = L oggerGroupl

Mew Logger
Delete

Start Recording
Stop Recording

Properties
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Loggers

In this section we explain how to use the configuration console to add, edit, and delete loggers.

Adding a Logger to a Tag Group

Ensure the runtime service is stopped.

2. Right click on the logger group that the logger will be added to and then click New Logger in the popup
menu, or click the logger group to select it and then click the New Logger icon on the Quick Launch toolbar.

' =

B MX-AOPC UA Logger
File

le Server I__o_ggel Tools Runtime Help -
TEREERSHRG008E
Type

=5 ‘ Server Group Logger Name

Output

...... a
MNew Logger
Delete
Start Recording
Stop Recording
Properties
Date Time Event
2018/05/06 16:19:09 Connect to Serverl success!
20160508 14:52:40 Server1 disconnect!
2018/05/06 14:50:08 Connect to Serverl success!
2018/05/06 14:42:35 Server1 disconnect!
2018/05/06 14:42:15 MX-ACPC UA Logger runtime service is stop.
4 1 3

|Service Status : Stopped Tirme: 16:23:03
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3. Type in the name of the logger, configure the data file type or database, and then click Next.

Logger Settings _ &

Logger Mame OggEl

(max. length = 30)

(@) Excel File
Root Path: C:Wsers\Public\DocumentsMoxa \MXAOPCLogger \Logger m

(71 Access File:

Root Path: C:\Wsers\Public\Documents Moxa M AOPCLogger \Logger

(71 Database:

Source Mame: Setiing

< Back Mext = ] [ Cancel

» Logger Name: The naming rules of the logger name depend on the specifications of Microsoft Excel,
Access, SQL Server, or Oracle Database. The naming rules can be summarized as follows:
. Microsoft Excel (max. length = 30; the first four characters: a-z, A-z; the following characters: 0-9,
a-z, A-Z, )
. Microsoft Access (max. length = 30; the following characters are NOT allowed: . ! ~ []"'),)
. Database Source Name (DSN) (max. length = 30; the following characters are NOT allowed: . []
)
» Excel File: Select this option if you would like to record data into Excel files. Configure the root path for
saving those files.

» Access File: Select this option if you would like to record data into Access files. Configure the root path
for saving those files.

» Database: Select this option if you would like to record data into a Microsoft SQL Server or Oracle
database.

5-6
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4. Select the Data Field items, change the default names in the Table Field, change the order of the items, and
if necessary change the time format for the timestamp. Click Finish to save the settings.

Logger Settings Iﬁ
Data Field *Table Field Data Type ~ || i
<TAG_ID= <TAG_ID> String [ W E
<WALUE > =VALUE = Siring
<UNIT> <UNIT > String E
<SOURCE_UTC _TIMESTA... <=S50URCE_UTC_TIMESTA... **DateTime
<SOURCE_TIMEZOME > =SOURCE_TIMEZOME > Float

] <DATA_TYPE:
[C] <SERVER_UTC_TIMESTA...
[Fl <SERVER TIMEZOME: b
*max. length = 30; . ™ [ ]" are not allowed.
== pption: DateTime or String
[ Automatically start recording when service starts runming.
« Back H Finish ] [ Cancel

> Data Field: By default, data of <TAG_ID>, <VALUE>, <UNIT>, <SOURCE_UTC_TIMESTAMP=>,
<SOURCE_TIMEZONE=> will be recorded into the database. Data of <DATA_TYPE>,
<SERVER_UTC_TIMESTAMP>, <SERVER_TIMEZONE>, and <QUALITY> are optional. The time data of
<SOURCE_UTC_TIMESTAMP> and <SOURCE_TIMEZONE=> in an OPC tag is added by Moxa’s 1/0 device
when the event occurs. The time data of <SERVER_UTC_TIMESTAMP> and <SERVER_TIMEZONE=> in
an OPC tag is added by the MX-AOPC UA Server when the tag is received.

» Table Field: The name of each data field, which can be defined by the user, will be the column name of
the table in the database. The max. length is 30 characters.
The following characters are not allowed: , “ [ ].

» Data Type: The data type of the timestamp can be either DateTime or String type. If the second value
of the timestamp has decimal points, select String type to record the decimal point value into the
database. The DateTime format only supports integer values.

> E: Move the selected item up.

> E: Move the selected item down.

» Automatically start recording when service starts running: Enable this function if you want the
logger to start recording automatically whenever the runtime service starts running.
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Editing a Logger

Take the following steps to edit a logger’s properties:

Ensure the runtime service is stopped.

click the Properties icon on the Quick Launch toolbar.

Right click the logger and then click Properties in the popup menu, or click the logger to select it and then

i oo D e
File Server Logger Tools Runtime Help
rewneees gRlscoss

=2 , Server Group
I Server1(192.168.12.112:53197)

Recording

| start Stop |

[ Automatically start recording when service starts running

Tag Selection
E|§:] Logger Group List [Serverl v] [AH Device v] @
E‘ﬂ Lo\ggerGroupl Available Tags Selected Tags
..... =
Delete Tag Mame D » Tag Mame
i DAC-0L.AI-00 z]
Start Recording ¥ DAC-DLAI-O1 E
Stop Recording 9 DAC-DLAI-02 E
i DAC-0LAI-03 -
Properties 4 n +
Server Mame  Tag Mame Description
=
< T b
Date Time Event
2018/05/06 16:19:09 Connect to Serverl success!
20160506 14:52:40 Server 1 disconnect!
2018/05/06 14:50:08 Connect to Serverl success!
2018/05/06 14:42:35 Server1 disconnect!
2018/05/06 14:42:15 MX-AOPC UA Logger runtime service is stop.

4 i ]

Service Status : Stopped Time: 17:53:16
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Deleting a Logger

Take the following steps to delete a logger:

Ensure the runtime service is stopped.
2. Right click the logger and click Delete in the popup menu, or click the logger to select it and then click the
Delete icon on the quick launch toolbar.
e L. . eleesd
| File Server Logger Tools Runtime Help
rewneeesseflooss

Server Group Recording :

[ Server1(192.168.12.112:53192) = = |

[] Aautomatically start recording when service starts running

Tag Selection
E|§:j Logger Group List [Servarl v] [AU Device v]
=5 L°PQE'G'°“91 Available Tags Selected Tags
-
Dolete Tag Mame |:| » Tag Mame
i DAC-DL.AI-00 E]
Start Recording i DAC-01.AI-01 E
Stop Recording W DAC-DLAI-02
% DAC-01.AI-03 - :
Properties Ll m 3
Server Name  Tag Name Description
o
¢ I r
Date Time Event
2016/05/08 16:19:09 Connect to Server1 success!
2018/05/06 14:52:40 Server 1 disconnect!
2018/05/06 14:50:08 Connect to Server1 success!
2018/05/06 14:42:35 Server 1 disconnect!
2018/05/06 14:42:15 MX-ACPC UA Logger runtime service is stop.
4 |s ] T »

Time: 17:54:54
3. Click OK to confirm that you would like to delete this logger.

MX-AOPC UA Lugge_rL EA

Do you really want to delete this logger? |

ok || concel |
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Logger Recording

In this section we explain how to use the configuration console to select tags for recording, to start or stop

recording, and to check the status of a logger.

Select Tags for Recording

1. Ensure the runtime service is stopped.

2. Ensure that the server is connected.

3. Click the refresh button to get the updated tags from the server.

T T T ——

File Server Logger Tools Runtime Help

NERBERPSERGT008E

é Al |
B I Group Recording
erver1(192,168.12,112:53192) e T
Start | | Stop
[ Automatically start recording when service starts running
Tag Selection
(= H Logger Group List [Serverl v] [AII Device - ]@d
=& ‘L%FQE'G“’“D]- Available Tags Tags
i Loggerl

Tag Mame » Tag Mame

“ DAC-0L.AI-00 z]

“DAC-0LAI-01 E

i DAC-DL.AI-02

i DAC-DL.AI-03 E

4 [

Server Name  Tag Name Description

=
< i b

Date Time Event
2018/05/06 16:19:09 Connect to Serverl success!
2018/05/06 14:52:40 Server 1 disconnect!
2018/05/06 14:50:08 Connect to Serverl success!
2018/05/06 14:42:35 Server 1 disconnect!
2018/05/06 14:42:15 MX-ACPC UA Logger runtime service is stop.

< 1 ]

Service Status : Stopped Time: 18:04:17 o
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4. Select the tag in the Available Tags list and click the arrow button to add it into the Selected Tags list.

Tag Selection

[Seruerl v] [All Device v]

Available Tags Selected Tags

Tag Mame Tag Mame

L " DAC-D1.AT-00

T DAC-01.AI-01
Ty DAC-01.AI-02
% DAC-01.AI03 -
i 1 3 i | Il P

T

Server Mame  Tag Mame Description

> E]: add all tags into the Selected Tags list.
> E: add a selected tag into the Selected Tags list.
> E: remove a selected tag from the Selected Tags list.

> E: removed all tags from the Selected Tags list.

5. The data from the tags in the list shown below will be recorded after the logger is in recording mode.

Tag Selection
Serverl v] [All Device v]
Available Tags Selected Tags
Tag Mame E > ; Taag Mame =
E] ¥ DAC-0L.AI-00 L4
E] % DAC-01.AI-01
% DAC-OL.AI0Z2
E] W DAC-01.AI-03 -
< | i | + [ m | [atd

Server Mame  Tag Mame Description

Serverl ¥y DAC-01.AI-00

Serverl ¥ DAC-0LAIO1
Serverl %y DAC-D1.AI-02
Serverl T DAC-01.AI-03
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Start or Stop Recording

P wN R

Ensure the runtime service is running.

Ensure the server is connected.

Ensure the logger is in ready mode (indicated by green lights).

To start recording all loggers in one logger group, right click on the logger group and then click Start
Recording in the popup menu, or click the logger group to select it and then click the Start Recording icon
on the Quick Launch toolbar.

& s D =

File Server Logger Tools Runtime Help

rEREERS S&a 0oEs

=3 Server Group Logger Mame Type Output
rver1(192.168.12.112:53192) Logger1 Excel C:\Users\Public\Documents Moxa \MXAOPCLogger \Logger\Logger 1_20160420_05...
Logger2 Excel C:Wsers'Public\DocumentsMoxa \MXAOPCLogger \Logger\Logger2_20160424 22,..

(- & Logger Group List

Mew Logger
Delete

Start Recording
Stop Recording

Properties
Date Time: Event D
2016/04/24 2217:27 LoggerGroup1.Logger2 sucessfully connected to database! g
2016/04/24 221727 LoggerGroupl.Logger 1 sucessfully connected to database!
2016/04/24 22:17:25 MX-AOPC UA Logger runtime service is running.
2016/04/24 22:17:25 Initializing service. ..
2016/04/24 22:17:10 MX-AOPC UA Logger runtime service is stop.
2016/04/24 22:16:57 LoggerGroup1.Logger 1 sucessfully connected to database!
2016/04/24 22:16:57 LoggerGroupl.Logger2 is invalid. Mo tagis selected.
.
An1c A A EEIRPNT MY ANOC 118 | nmnne e b aneien e i
] I | r

ervice Status : Running Time: 22:17:32

5. All of the loggers in the logger group will be in recording mode (indicated by red lights).

(oo R

File Server Logger Tools Runtime Help

NrEEBERPSERG 008 E

& ' Server Group Logger Name Type Output
"""" u Server1({192.158.12,112:53193) Loggerl Excel CiJsers'\Public\Documentsy,
Logaer2 Excel CiWsers'\Public\Documentsy,

=~ Logger Group List
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6. To start recording a specific logger, right click on the logger and then click Start Recording in the popup
menu, or click the logger to select it and then click the Start Recording icon on the Quick Launch toolbar.

-
H MX-AOPC UA Logger

 File Server Logger Tools Runtime Help

TEmEEBRSERGO0EE

[ . Server Group Recording
------- 5 Server1(192.168.12.112:53192) [

sart | | sop |

[ ] Automatically start recording when service starts running
Tag Selection

= Logger Group List | v| | v| |"1
=- & LoggerGroup1 Available Tags Se

g _ Tag Mame lL'
Delete >
KB
Wl

Start Recording

Stop Recording l:l

Properties

| | Server Mame  Tag Mame

Carvar T NACA1 ATAN

7. To stop recording, right click on the logger group or the logger and then click Stop Recording in the popup
menu, or click the logger group or the logger to select it and then click the Stop Recording icon on the
Quick Launch toolbar.

.
& MX-AOPC UA Lug_

File Server Logger Tools Runtime Help

= - Server Group Logger Mame Type Output
"""" ‘ Server1(192.168.12.112:53192) Logger1 Excel C:\Users\Public\Documen
Logger2 Excel C:\Users'\Public\Documen

= E Logger Graup List

ER <] ogoercroup U

""" ‘Q" Loggerl Mew Logger
Delete

Start Recording
Stop Recording

Properties
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8. To check the recorded data, stop the runtime service and click the data folder of the logger. Open the data
file in the folder to check the recorded data.

File Server Logger Tools Runtime Help

TERBERPSERG00SE

(=38 B Server Group Recording L
Ei ﬁ Server1{192,168.12.112:53197) z
[ Automatically start recording when service starts running
Tag Selection
E-E Logger Group List | ~| | | G|
=] L°QQE'G'°“91 Available Tags Selected Tags
) Logger1 P
i Logger2 Tag Mame L L2 Tag Mame
| » | =
4
«
Server Mame  Tag Mame Description =
Serverl % DAC-DL.AI-00 Al |
Serverl “ DAC-DLAIO1 Al
Serverl iy DAC-DLAI02 Al - L
< i ¥
Property
Type: Excel
Output:  C:\Users\Public\DocumentsMoxa\MXAOPCLogger\Logger\Logger2_20160424 22164 I
Table: Logger2
| nata Field Tahle Field Nata Tune arele « | B
Date Time Event =
2016/04/24 23:11:58 MX-AOPC UA Logger runtime service is stop. D
2016/04/24 22:47:20 Start recording logger group LoggerGroup' -
< | [l ] 3
Service Status : Stop Time: 23:12:13

Organize = Include in library - Share with = Mew folder

Mame Date modified

B Desktop LoggerZ_20160424_ 222452 x|= 2016/4/24 T
& Downloads

.0 Favorites
“El Recent Places ‘

NOTE Be sure to close the Excel or Access file at the target root path before starting to record. Otherwise, the
MX-AOPC UA Logger will not be able to record data to the target file.

NOTE DO NOT open the spreadsheet when recording. Doing so will cause the file to be corrupted because it is already
opened by the MX-AOPC UA Logger service. To open the spreadsheet, stop the runtime service of the MX-AOPC
UA Logger, and then click the folder icon to access the file.
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Logger Management

Logger Status

The following table gives the meanings of the logger status indicator lights.

Light

Color

Status

Note

Solid Gray

Configurable Mode

The logger can be configured only when
runtime service stops.

Any configuration change will be updated to the
Logger’s runtime service after starting the
runtime service. Without starting the runtime
service, any change will be discarded after the
configuration console is closed. Be sure to save
your project file when you close the
configuration console.

Solid Green

Ready Mode

The logger is ready for recording.

Solid Red

Recording Mode

The logger is recording.

Solid Yellow

Error Mode — Configuration

The logger is not configured correctly, and data
is not being saved to the database.

Check the tag selection or database connection
of the logger.

A server related to some selected tags is

© © © 00 ¢

Flashing Red disconnected.
Error Mode — Server i
and Yellow Check the server connection or server’s
Endpoint settings.
N . . The logger is retrieving supplementary data
Flashing Pink i i
Data Supplement Mode from device’s buffer storage or supplementing
and Gray

data into the database.
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License Registration and Activation

Three versions of the MX-AOPC UA Logger are available. The trial version, which supports up to 1 MX-AOPC UA
Server connection and up to 1 data logger, can be installed and used for 30 days without registration. To use

the free and paid versions you must submit a license registration. Both free and paid versions can be used
indefinitely, but the free version only supports up to 1 MX-AOPC UA Server connection and up to 1 data logger.
The three versions are summarized in the following table:

Version MX-AOPC UA Server connection Data Logger Run Time License File
Trial Uptol Uptol 30 days Not Required
Free Upto1l Upto1l Unlimited Required
Paid Up to 2 Up to 10 Unlimited Required

Take the following steps to register a license.

Step 1:

Get the PC User Code from the MX-AOPC UA Logger’s configuration console by clicking Help - License. For
the paid version, you will need to purchase a registration code from your Moxa distributor. The Registration

Code can be found on the product label.

License Info
il

e S|

User Code: 464EB14358CD
License Status: Free Version
The max, number of Server; 1

The max. number of Logger: 1

MOXA®

MIN:

Product S/N: I‘L!I!!\L![!M"IIII
0.0

Rev: 1.

Made in Taiwan
PIN: 3093015000021

Registration Code: | I || [HIHHHI

TZADO10000001231
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Step 2:
Go to Moxa’s Software Licensing website (http://license.moxa.com) and log in with your Moxa account and
password, or apply for an account if this is your first visit to the site.

Step 3:

On the Software Licensing website, navigate to Activate Your Software > Software Package > MX-AOPC
UA Logger. Select Free Version and enter the User Code, or select Paid Version and enter both the User
Code and Registration Code.

MOX/\  Software Licensing

Home = Activate Your Software = Software Package = ME-ADPC UA Logger

Free Version
User Code: | |

= Paid Version

Registration Code: | |
User Code: | |

Step 4:
Download the license file to a folder on your PC and unzip it.

Step 5:
From the MX-AOPC UA Logger’s configuration console, click Help = Licensing - Add License File to add the
license file (.lic) to the MX-AOPC UA Logger.

& MX-AOPC UA Loge
File Server Logger Tools Runtlme I_

— — e ﬁ ﬁ ﬁ Legger Help

Licensing

License Info

= ﬁ Server Group About... Add License File
------- B Server1(192.168.12.112:5319 ‘ |

Deactivate License

6-2


http://license.moxa.com/

MX-AOPC UA Logger License Registration and Activation

Step 6:
After license activation is complete, go to Help = License Info to check the current license status.

; Your license has been activated. The new license will take effect after

runtime service restarts,

OK

e =
i—i
User Code: 464EB14358CD

License Status: Free Version
The max. number of Server; 1

The max. number of Logger: 1
e

|
I
User Code: 464EB14358CD

License Status: Paid Version
The max. number of Server; 2

The max. number of Logger: 10
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